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WHAT IS REFWORKS?  
RefWorks is a web-based citation management service used for storing and organizing citations, as 
well as automatically formatting bibliographies with Microsoft Word.  It is similar to EndNote, 
but your citations are stored on the RefWorks server rather than on your local machine and thus 
you must be connected to the Internet to use RefWorks. RefWorks is free to University of 
Michigan faculty, students and staff while you are part of the University. 

CREATING AND ACCESSING YOUR REFWORKS ACCOUNT  

ON CAMPUS 
To set up a RefWorks account on campus, you can 
go directly to http://www.refworks.com/refworks/.  
RefWorks will recognize the IP address on your 
computer as U of M and the RefWorks User Login 
for the University of Michigan University Library 
window will appear.  Select Sign up for an individual 
account.    

OFF CAMPUS 
If you are off campus, youõll need to go through the 
Library website at http://www.lib.umich.edu/.  
Select Find Databases from the options list under 
General Search on the left side of the screen and 
type òRefWorksó for a link to RefWorks.  Youõll be 
asked to authenticate using your uniqname and 
password.   

 

CREATING YOUR ACCOUNT 
In the New User Information for University of Michigan Library 
screen, enter your name, login name, password, U of M e-mail address, 
type of user, and area of focus then select Register. Once youõve 
registered, a confirmation will be sent to your e-mail address.  Youõll 
also receive periodic updates from RefWorks on enhancements and 
upgrades.  

 

NOTE:  Since your RefWorks information is kept offsite, we 
recommend that you DO NOT use your UM Kerberos password, but 
select another password of your choice. 

http://www.refworks.com/refworks/
http://www.lib.umich.edu/


Automatically Creating Citations and Bibliographies with RefWorks 
A University of Michigan Library Instructional Technology Workshop 

Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library. 

exploratory@umich.edu    |   http://www.lib.umich.edu/guides   |    knc-info@umich.edu 

rev: 5/21/08 

3 of 14 

THE REFWORKS WINDOW  

 

MGet It  is a tool provided by the University Library that creates shortcuts to the full-text of 
online articles, as well as links to other Library services. 

 

Search for 
keywords 
and lookup 
by term. 

Create, import, 
and export 
citations using 
these menus. 
 Sort, delete, 

edit, and 
organize 
citations.  

Citation 
preview. 

Use MGet it 
to access 
full-text and 
other Library 
services 
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ENTERING CITATIONS INTO REFWORKS  
Once your account has been setup, you are ready to begin populating your RefWorks database 
with citations.  There are a number of ways to enter citations into RefWorks, including manually 
entering citations, importing citations from online databases, and using the Search Online 
Database feature.   In addition, RefWorks now offers a direct import feature of EndNote libraries. 

MANUALLY ENTERING CITATIONS  
1. To enter a citation into RefWorks, go to the 

References menu and select Add New Reference. 

2. The New Reference screen will appear.  

3. Choose the citation format (book, journal article, etc.) 
from the Ref Type pulldown menu ð this determines 
how the item will look in the bibliography. 

4. Put in as much information as you have. Separate 
multiple authors and descriptors by semicolon, and 
enter authors with the last name first.  If youõd like, 
select a format from the View fields used by: pulldown 
menu, but you can just leave it at the default. 

5. Choose a folder if you have one in mind from the In 
Folder(s) pulldown menu near the top. 

6. When youõre finished entering the information, click the Save button.  You then have the 
option to Duplicate, View, or go Back to the Reference List.   

DIRECT EXPORT FROM ELECTRONIC RESOURCES TO REFWORKS 
Rather than manually enter citations, you also have the option to import citations directly from 
many online databases (FirstSearch, ProQuest, etc.). There are basically three steps: 

1. Go to the online database and conduct your search. 

2. Mark the records for saving/exporting (this will look different in different databases). 

3. Figure out how to export/save it to RefWorks. 

Because all the databases look and act differently, exactly how you go about these steps varies. 
Here are a few examples of what the export step might look like:   

 

Cambridge Scientific Abstracts 
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FirstSearch ProQuest 

 

After you activate the Export feature, the RefWorks window will come to the front of your 
screen, and youõll see a message indicating that the references are being imported and when the 
import is complete.   

 

SAVING CITATIONS AS TEXT AND IMPORTING INTO REFWORKS  
While many databases have the direct export feature, some (like Mirlyn, for example) do not. With 
these resources, you need to save your results as a text file, and then import them into RefWorks.  
Thereõs no list that tells you if a database has the direct export option or if youõre going to have to 
save it as a text file. You can go to the database and see if there is a direct export to RefWorks, or 
go to RefWorks and see if there is an import filter  available. The import filter is what tells 
RefWorks where the data came from, and how to interpret it correctly (so RefWorks knows what 
is the author, the title, etc.).  

To see if the database youõre using has a RefWorks import filter, go to the References menu and 
select Import . On the Import screen, use the Import Filter/Data Source pulldown menu choose the 
vendor of the database, and then choose 
the specific database in the Database 
pulldown menu. 

To import a text file into RefWorks, first 
you have to save the text file from the 
database you are using  

1. Follow the instructions for the 
database youõre using to save the 
citations as a text file on your 
computer. See our FAQ for 
step-by-step instructions at 
http://www.lib.umich.edu/knc/howto/citation/refworks/text.html 

2. Once you have the text file, go to RefWorks and then go to the References menu and 
select Import.  

http://www.lib.umich.edu/knc/howto/citation/refworks/text.html
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3. On the Import screen in RefWorks, select the Import Filter/Data Source (University of 
Michigan University Library, ISI, NLM Gateway, etc.) 

4. Depending on your data source, you may need to specify the database in the Database 
pulldown menu. 

5. If desired, choose an existing folder from the Import References into Folder pulldown menu 
(more about creating folders later in the document.   

6. Be sure that Import Data from the following Text File radio button is selected and click on the 
Browse button to navigate to your text file and select it.  Scroll to the bottom of the screen 
and select Import.  Your citations will be imported into RefWorks. (Note you could also 
copy your results and past them into the Import Data from the following Text box and then 
click Import.)  

7. After you click the Import button, RefWorks will 
import the records, tell you how many were 
imported, and give you the option to view the last 
imported folder or return to your reference list. 

SEARCH ONLINE DATABASE 
This is the least recommended method, as you do not get the full search capacity of the database 
you are using. However, the Search Online Database feature allows you to search library catalogs 
from within RefWorks, and this is handy if you know that the catalog has a specific item. 

1. Go to the Search menu and choose Online Catalog or 
Database. 

2. On the Search Online Databases screen, choose the catalog 
(for example, University of Michigan to search Mirlyn, our 
library catalog). 

3. Indicate how many references to download at one time in the 
Max. Number of References to Download pulldown menu. 

4. Enter your search terms ð we recommend using the Advanced 
Search for: section rather than the Quick Search for: box. In the 
advanced area, be sure to choose AND , OR, or NOT  from 
the pulldowns between the terms. 

5. Once you have your terms entered, click on the Search button, 
and your results will appear in a new RefWorks window.   

6. Use the checkbox next to the item to select the ones you want, and then click the Import 
button to bring the citations 
into RefWorks.  If you select 
a specific folder from the 
Import to Folder pulldown 
menu, you can place your 
citations directly to a 
particular folder.   
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ORGANIZING YOUR CITATIONS 

CREATING FOLDERS 
You can create folders to organize your citations by going to the 
Folders menu and select Create New Folder.  Type the name of 
your folder in the New Folder Name field and click on the OK button.   

You can create an unlimited number of folders within your RefWorks account. You cannot create 
subfolders.  You can, however, place the same reference in more than one folder. 

ORGANIZING YOUR CITATIONS WITH FOLDERS 
After you create folders, you can put items into them to organize yourself, and you can put the 
same citation in more than one folder if thatõs appropriate. They will also always show up in the 
All References list, and if you remove a citation from a folder, it will still be in your RefWorks 
database. 

1. To organize your citations into folders, use the 
checkbox next to the citation to select it.   

2. Go to the Put in Folder pulldown menu and select the 
appropriate folder.   

3. A javascript message will appear that asks òAre you sure 
you want to put the [number of references] selected references in 
the [Selected] folder?ó  Click OK.   

4. Youõll then see a message indicating that your 
citations have been successfully put in the folder.  You 
may need to click OK to dismiss the dialog box.  

FINDING DUPLICATE CITATIONS 
There are actually two ways to find the duplicates in your RefWorks database: 

¶ Go to the Tools menu 

¶ Go to the View menu 

In both cases, youõll then have the 
opportunity to choose Close Match or 
Exact Match. 

Youõll want to view both references to 
make sure you keep the one with the 
most information (or that youõve used 
in a document). 

Delete the ones you donõt want by 
checking the checkbox next to the 
citation then clicking on the Delete button (you can select more than one before you click the Delete 
button). 
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SEARCHING FOR C ITATIONS IN YOUR REFWORKS DATABASE 
The Search RefWorks field on the top right side of the screen 
searches across your RefWorks database.  It looks in all fields, 
including the abstract and custom fields.  All search terms are 
connected by the Boolean connector AND . It also searches for 
embedded terms, i.e., if you search for òartó you will retrieve 
references with òheartó, òpart,ó etc.   

The Advanced Search (located under the Search menu) 
allows you to limit your search to specific fields (author, 
title, abstract, etc.), select Boolean operators (and, or, not), 
as well as select the folders you wish to search. 

You can also use the Lookup by Author, Descriptor, or 
Periodical, also found under the Search menu. 

 

 

EXPORTING REFERENCES FROM REFWORKS 
If you need to export citations from RefWorks to EndNote, for example, go to the References 
menu and choose Export (you can also go to the Tools menu and choose Export). 

1. On the Export screen, 
choose the appropriate 
item in the References to 
Include section. 

2. In the Export Format 
section, choose how you 
would like the file 
formatted. 

3. Click the Export to Text File 
button. 

4. A new window will open with the file formatted in the correct way. Using your browserõs 
save page function (where this is located depends on the browser), save the file to your 
Desktop or wherever you would like to save it. 
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EDITING INFORMATION IN YOUR CITATIONS 
You can edit any citation by clicking the Edit button for that citation. Depending on how you are 
viewing the citation, this Edit button will be in different places: 

¶ Standard View: to the right of the reference, there are View and Edit buttons. 

¶ One line/Cite View:  click on the View button to the left of the citation, then when the 
record opens, the Edit button will be at the top left. 

¶ Full View: to the right of the reference, there are View and Edit buttons. 

Once you are in the Edit Reference screen, make any changes you want, and then click the Save 
Reference button at the top. 

CHANGING MULTIPLE CITATIONS AT ONCE 
There are times when you need to change the same thing across many records. For example, if 
you find a typo in an authorõs name, you want to add the same keyword (called Descriptors in 
RefWorks) to several records, or perhaps you want to change all occurrences of a particular term. 

CHANGE BY LOOKUP 

1. Go to the Search menu and choose Lookup by 
Author, Descriptor, or Periodical. 

2. Click the Edit button next to the term. 

3. On the Descriptor Global Edit page, type in the new 
term and click the OK button. This will change all 
occurrences of the old term to the new term (only in the 

field selected). 

 

 

 

CHANGE BY GLOBAL EDIT BUTTON 

You may want to add your own descriptors to 
your citations.  

1. Mark the relevant citations, and click on 

the Global Edit button. 

2. On the Global Edit screen, be sure the 
Selected radio button is checked 

3. Choose the correct Field to Edit and put the 
change in the Change Field to box. 

4. Choose the appropriate radio button in the 
If Field Already Contains Data section. 

5. Click the OK button.  
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SHARING YOUR REFWORKS DATABASE 

READ-ONLY ACCESS 
RefWorks allows you to provide read-only access to your database. By creating and 
sharing a Read-only password, others will be able to search your database, export 
data and create bibliographies, but they will not be able to edit references, import 
references or change folders.  

To make your database read-only, go to the Tools menu and choose Update User 
Info . Enter a read-only password (different from your original password) and click 
Update. With your login name and read-only password, users will be allowed to 
access your database in read-only mode.  

USING REFWORKS FOR GROUP RESEARCH PROJECTS  
RefWorks is a great tool for group research projects.  By creating an account to share, you and 
your group members will be able to add citations from anywhere you have Internet access. Here 
are some tips to help you to use RefWorks efficiently as a group. 

CREATE A SEPARATE ACCOUNT FOR THE GROUP  

Group accounts are created exactly the same as individual accounts ð choose Sign up for an 
Individual Account from the main RefWorks screen. Choose a Login Name and Password that 
will make sense to your group (donõt forget to share these with the group!).  For example, pick 
something that has the class or project name in it, like òarteducationó or òbiochemlab4ó. 

USE FOLDERS TO ORGANIZE C ITATIONS  

To facilitate organization amongst group members, create folders to store your citations. You 
could create folders for different topics and/or a folder for each person working on the project ð 
whatever works best for your group.  Remember that citations can display in multiple folders.   

CREATE CONSISTENT VOCABULARY USING DESCRIPTORS  

Using descriptors creates a consistent vocabulary across your RefWorks database making it easier 
to search and retrieve relevant citations within your RefWorks database.  If youõve imported 
citations from a number of online library resources, different terms may be used to describe a 
similar thing.  For example, the words òjuvenileó and òchildó both may be used to describe kids, 
but your group may always want to use the word, òchildó.  

SELECT AN ACCOUNT MANAGER  

Select someone from your group to periodically check for duplicates, make sure citations are in 
the proper folders, etc.  If your account needs some cleanup work that the manager canõt do, s/he 
can let the group know what needs to be done. 
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ADDING CITATIONS TO YOUR WORD DOCUMENT 
There are two main ways to add RefWorks citations to your Word document ð One Line/Cite 
View and using the Write-N-Cite plug-in. The big difference is that with the One Line/Cite View, 
you have to copy and paste each reference; with the Write-N-Cite, you click the Cite button and it 
places it in your document. 

ONE LINE/C ITE VIEW MANUSCRIPT  
To cite a reference in your paper, youõll need to 
switch to the One Line/Cite View by choosing it 
in the Switch to: pulldown menu.   

 

1. Click on the Cite button next to the appropriate reference.   

2. A Citation Viewer window will appear containing the citation formatted as at right. If you 
are citing more than one item, click the Cite button and it will get added to the existing 
citation. 

3. Once youõre set, click on the 
Select Citation button.   

4. Copy the citation, then go to 
your Word document and paste 
it in the right place, or drag and 
drop the citation into your 
document. 

5. Be sure to clear the Citation 
Viewer window before creating 
your next citation. 

Once youõve added all the citations to 
your document, see the Creating a Bibliography for your Word Document section on page 13 to generate 
the bibliography for this document. 

EDITING YOUR IN-TEXT C ITATION 

There are times when you want to change what the in-text or footnote citation looks like; for 
example, you want to omit the author or year, or add page numbers. If you are not using the 
Write-N-Cite method described in the next section, you have to add these òswitchesó manually. 
For example, to omit the author from an in-text citation you would add /a  after the year, but still 
in the brackets: 

{{42 Smith 2003/a}} 

For a list of all RefWorks switches, please visit the RefWorks Help website: 

https://www.refworks.com/Refworks/help/refworks.htm - Modifying_an_In-
Text_Citation_or_Footnote.htm. 

https://www.refworks.com/Refworks/help/refworks.htm#Modifying_an_In-Text_Citation_or_Footno
https://www.refworks.com/Refworks/help/refworks.htm#Modifying_an_In-Text_Citation_or_Footno
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USING WRITE-N-CITE 
The Write-N-Cite plug-in runs an abbreviated version of RefWorks in your word processor. You 
have to download and install the UM version of Write-N-Cite because we do not use a RefWorks 
group code, and if you download the one from the RefWorks website it wonõt work properly. If 
you havenõt installed it yet, go to our website and download it. Installation instructions are also 
available there (http://www.lib.umich.edu/help/refworks/write.html).  

Once Write-N-Cite is installed, an icon will display in your Word toolbar.  

1. Click on the Write-N-Cite icon in the toolbar.  

2. The Write-N-Cite window will open. If you are not logged into your RefWorks account, 
you will be prompted to do so at this time. 

3. Navigate to the desired citation and 
click on the Cite button. 

4. The citation will appear wherever 
your cursor was in your Word 
document. 

a. If you need to add another 
reference to this spot, leave the 
cursor where it was and repeat 
step 3. The second citation will 
get added within the double 
brackets (as shown at right). 

5. Move your cursor to the next place to insert the citation, and repeat as needed. 

Once youõve added all the citations to your document, see the Creating a Bibliography for your Word 
Document section below to generate the bibliography for this document. 

EDITING YOUR IN-TEXT C ITATION 

There are times when you want to change what the in-text citation looks like; for example, you 
want to omit the author or year, or add page numbers. 

1. Insert the citation(s) as described 
above. 

2. Click on the Edit Citation button in 
the upper right corner (shown in 
picture above). If you are coming 
back to a citation later, make sure 
you put your cursor somewhere in 
the citation first. 

3. Make the changes in the Citation 
Editor window as shown at right. 

4. Click the Save to Word button at the 
bottom of the screen. 

 


